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A.  Will you require JoVE to record video microscopy, such as filming a complex dissection or microinjection technique? (Y/N)__No______   
B.   Does your protocol include detailed, step-by-step, descriptions of software usage? (Y/N)____Yes____ If yes, we will need you to record using screen recording software to capture the steps. If you use a Mac, QuickTime X also has the ability to record the steps.

C.  Which steps of your protocol will viewers benefit most from having filmed? Please list 4-6 individual steps using the step numbers listed in this document. (Please do not list entire sections.) ________________3.1-3.4, 3.7______________________
D.  What is the single most difficult aspect of this procedure and what do you do to ensure success?  Please list 1-2 individual steps using the step numbers listed in this document. (Please do not list entire sections.) ___3.4,  very careful dissection is needed to ensure success________
E.  Will the filming need to take place in multiple locations? (Y/N) ____No__ If yes, how far apart are the locations? ____all in the vivarium_________________________________

1. Introduction (Experimental Goal and Author Interviews) – As the beginning of your video, the introduction should clearly present the goal of your method to the viewer and its significance.  Other information can be provided according to the various statements below, but the total introduction should not exceed 150 words. 

A. Experimental Goal (read by voice talent at JoVE): 
 The overall goal of this experiment is to determine the relative tumor burden of intra-peritoneal ovarian cancer metastasis in a syngeneic orthotopic xenograft murine model.  (Intro)
B.  Required Interview Statements: (Said by you on camera. Don’t forget to smile!)   
1.1. Stack:  This novel method, used to image and quantify the relative tumor burden, can help answer key questions regarding the regulation of ovarian cancer metastasis .

1.2. Lewellen: The fundamental advantage of this technique is that by unmixing the fluorescent spectra, tissue autofluorescence is removed from the images, enabling the measurement of standardized, relative tumor burden.   

C.  Optional Interview Statements: (Said by you on camera. Don’t forget to smile!)   
1.3. Stack:  This technique lends insights into human ovarian cancer metastasis with implications toward monitoring the efficacy of therapeutics.  
1.4. Lewellen:  Visual demonstration of this method is critical because it couples a robust imaging technique with an analytical procedure to extract quantitative data from the images.

1.5. Stack:  Demonstrating the procedure will be Yueying Liu, who is the Laboratory Program manager for the Stack Lab.  
1.5.1. Interview style: Author saying the above 

1.5.2. The named technician, post doc, student looks up from workbench or desk or microscope and acknowledges the camera. 
E.  Ethics title card: (for human subjects or animal work, does not count toward word length total) 

1.6. Procedures involving animal subjects have been approved by the Institutional Animal Care and Use Committee (IACUC) or equivalent body at (the University of Notre Dame).
Protocol (read by voice talent at JoVE):  
2. In-vivo Imaging of ID8 Murine Ovarian Cancer Cells
2.1. After 10 weeks of tumor cell growth, place the body of each anesthetized mouse into a small animal optical imaging system, one at a time.  Scan all mice in the cohort at each time point.  [2.1.1 - MED]
2.1.1. Talent places anesthetized mouse into the scanner.
2.2. To observe fluorescently labeled tumor cells, execute a multispectral acquisition to collect a total of 5 images.  [2.2.1 - SCREEN] Select a standard exposure of 15 sec, 2 by 2 binning, a field of view of 16 cm, and an fstop of 1.1. [2.2.2. - SCREEN] 
2.2.1. Screen capture video as talent enters excitation/emission information. (TEXT: Multispectral Acquisition via excitation at 440 nm, 460 nm, 480 nm, 520 nm and 540 nm and emission at 600 nm.)

2.2.2. Screen capture video as talent enters parameters listed and starts scan.

2.3. Next, acquire a reflectance image of the entire animal using white light from an open excitation filter, an open emission filter, a standard exposure of 0.2 sec with 2 by 2 binning, and a field of view of 16 cm.[2.3.1 - SCREEN]
2.3.1. Screen capture video as talent as talent enters parameters listed and then starts scan.

3.  Mouse Dissection and Image Acquisition 

3.1. Following euthanasia, use pointed dissection scissors to cut the skin anteriorly along the ventral midline of the mouse, from the top of the thighs to the bottom of the rib cage. [3.1.1 - CU - TXT] 
3.1.1. Talent uses scissors to make the midline incision. (TEXT: Caution: Take extreme care to cut through only the skin layer.)

3.2. Gently separate the skin from the peritoneal tissue, being sure not to puncture the peritoneal wall. [3.2.1 - CU] Then, cut laterally both along the bottom of the rib cage and the top of the thighs to create two flaps of skin.[3.2.2 - CU]
3.2.1. *Film as written
3.2.2. *Film as written
3.3. Place the mouse on its ventral side in the scanner, so that the peritoneal cavity is facing downward with the skin flaps pulled open. [3.3.1 - CU] Scan the mouse with its organs in situ using the same parameters that were previously used for the live mouse.   [3.3.2 - MED]
3.3.1. *Film as written
3.3.2. Talent starts the scan.
3.4. Now, continue dissecting the mouse by extracting the liver, the omentum, the pancreas, the stomach, the diaphragm, and the small and large intestines using standard techniques.[3.4.1 - CU]
3.4.1. Talent removes some of the above organs.

3.5. Also, remove the left and right peritoneum, the ovaries, the kidneys, the mesentery, and lastly the fat pad. [3.5.1 - CU]
3.5.1. Talent removes some of the above organs.
3.6. Observe, enumerate, and record each of the visible tumors on the organs. Use a caliper to measure the diameter of each tumor. [3.6.1 - CU]
3.6.1. Talent uses calipers to measure and record some of the tumors.

3.7. Designate tumors that are less than 2 mm in diameter as small… in between 2 and 5 mm as medium… and greater than 5 mm as large. [3.7.1 - CU - TXT]
3.7.1. Talent uses forceps to point to a small tumor, then a medium tumor, and finally a large one. (TEXT: Small: < 2 mm, Medium: 2 - 5 mm, Large: > 5 mm)
3.8. Next, place the organs on the organ scanning template, found in figure 4 of the accompanying text protocol, and use it to organize the location of each organ during the next scan.  Use PBS to keep the organs moist. [3.8.1 - CU - TXT]
3.8.1. Talent places organs onto the template and then moistens them with PBS. (TEXT: *See Figure 4)
3.9. Scan each sheet of organs using the small animal optical imaging system and the parameters that were previously used. [3.9.1 - MED]
3.9.1. Talent places sheet of organs into the imaging system and begins imaging.
3.10. After scanning, place the organs in 10% formaldehyde and process them for histology using standard techniques. [3.10.1 - MED]
3.10.1. Talent places organs into formaldehyde.

4. Quantification of Tumor Burden in the Fluorescence Images

4.1. In order to reduce the amount of auto-fluorescence in each multispectral scan, first load the red fluorescent protein in vivo spectral file, followed by the Autofluor in vivo Red file in the unmixed Images window and select “unmix”.  [4.1.1 - SCREEN]
4.1.1. Screen capture video of the above step.

4.2. Then, export the .bip files in a 16 bit unscaled .tiff format and load them into ImageJ by going to “file”…“open”…. And then selecting the correct 16-bit .tiff file. [4.2.1 - SCREEN]
4.2.1. Screen capture video of the above step.

4.3. Next, go to the Image menu and select “Adjust”…then “Brightness/Contrast” and set the “minimum displayed value” to zero and the “maximum displayed value” to +35353.  Then, under “Image” menu again, go to “Lookup Tables” and select “Red Hot”. [4.3.1 - SCREEN]
4.3.1. Screen capture video of the above step.

4.4. Using the Freehand Selection tool, draw a free-form region of interest selection around each organ…  Then, type control and “m” to use the Measure tool to calculate the surface area of each organ.  Record this data in a spreadsheet. [4.4.1 - SCREEN]
4.4.1. Screen capture video of the above step.

4.5. With the region of interest that was drawn around each organ, right click and select “Duplicate” to include only the organ. [4.5.1 - SCREEN]
4.5.1. Screen capture video of the above step.

4.6. Then, under “Image”, go to “Adjust” then “Threshold” and set the “Lower Threshold Level” to +1200 and the “Upper Threshold Level” to +1700.  Also, check the “Dark Background” and then select OK. This will select only the most brightly fluorescing regions. [4.6.1 - SCREEN]
4.6.1. Screen capture video of the above step.

4.7. Under “Analyze” select “Analyze Particles” and change the size of the pixels squared to 10 to infinity.  Choose to show outlines and check to select only “Display results” and then click “OK”. This will measure both the areas and raw integrated densities of the bright regions, deemed tumors. [4.7.1 - SCREEN]
4.7.1. Screen capture video of the above step.

4.8. Record the values of the surface area and the raw integrated density of each tumor selection together in the same spreadsheet containing the organ surface areas. [4.8.1 - SCREEN]
4.8.1. Screen capture video of the above step.

4.9. Then, under “Analyze”, select “Tools” and go to “Calibration Bar”. Add a calibration scale bar to the images of the organs. [4.9.1 - SCREEN]
4.9.1. Screen capture video of the above step.

4.10. Next, under “File”, go to “Save As” and save the montage as both a .Tiff and a .Jpeg. [4.10.1 - SCREEN]
4.10.1. Screen capture video of the above step.

4.11. Then, open the .jpeg file of the organs and go to the “Insert” menu to add a text box to each image.  Add organ labels by creating a text box below each of the three rows of organs.  [4.11.1 - SCREEN]
4.11.1. Screen capture video of the above step.

4.12. Open each of the 16-bit .tiff files of the full body scans into ImageJ in order of mouse number. [4.12.1 - SCREEN]
4.12.1. Screen capture video of the above step.

4.13. Then, go to the “Image” menu and select “Adjust” and then “Brightness/Contrast”.  Set the minimum displayed value to 0 and the maximum displayed value to +35353.  Next, go back to the “Image” menu and to “Lookup Tables” and then select “Red Hot”. [4.13.1 - SCREEN]
4.13.1. Screen capture video of the above step.

4.14. Once this is complete, save the montage as both a .Tiff and a .Jpeg file. [4.14.1 - SCREEN]
4.14.1. Screen capture video of the above step.
5. Results: Quantitation of Ovarian Cancer Metastasis
5.1. The ID8 murine ovarian cancer cell line, that is injected into the mice 10 weeks prior to imaging, fluoresces in the red channel and continue to do so throughout growth.[5.1.1 - LM]
5.1.1. Figure 1 (Video Editor: Label Figure 1a “Phase Image” and Figure 1b “Fluorescence Image”

5.2. Live imaging using a small animal optical imaging system is able to view the expanding ID8 cells in the mouse and provides a more accurate approach than simply weighing the mouse in order to assess tumor burden.[5.2.1 - LM]
5.2.1. Figure 2a

5.3. Following euthanasia and removal of the ventral skin layer, the intact organs can be viewed in more detail, [5.3.1 - LM] however individual organs placed on the organ scanning template display the tumor burden clearly in each organ.[5.3.2 - LM]
5.3.1. Figure 3a

5.3.2. Figure 3c

5.4. The tumor burden in the omentum and pancreas, ovaries, and mesentery of the mouse shown on the left is much greater than those same organs in the mouse shown on the right.  [5.4.1 - LM] The observation of differential tumor burden is confirmed quantitatively both in terms of tumor surface area and tumor signal intensity. [5.4.2 - LM]
5.4.1. Figures 3c and 3d (Video Editor: Put Figure 3c on the left and 3d on the right. Label the left panel “Mouse A” and the right “Mouse B”. Outline the organs when mentioned.)

5.4.2. Figure 5a-b (Video Editor: Highlight Figure 5a with mention of “tumor surface area” and Figure 5b with mention of “tumor signal intensity”.)
6. Conclusion (said by authors on camera) 
6.1. Lewellen:  Once mastered, this technique can be used to image up to 18 living mice per hour.  Dissection and ex vivo imaging of individual organs takes a total of about 20 minutes per specimen.

6.2. Stack:   Following this procedure, other methods, like quantitative magnetic resonance, can be performed in order to address questions regarding the impact of obesity on ovarian cancer metastasis.
Provided Media

Authors, Please list all images, movie files, or 3-D rendered animations that can be included in the video per editor’s request.  The step in the script/video where these images will be inserted should be specified.   For example:

6.2 –  0123_PIname_Figure1.tif -  dual color imaging of tumor angiogenesis at 40X 

6.2 –  0123_PIname_Figure2.tif -  dual color imaging of tumor angiogenesis at 100X

Formats:  For static images we prefer .tiff, .eps, Illustrator, Powerpoint or Photoshop files at dimensions of at least 720X480 pixels and 300 dpi.  The higher resolution, the better.  Likewise any exported movie files should have at minimum these dimensions and be rendered to .mov, .mp4, or .avi files.  

Insert your media filenames here.

General Preparation

It’s critical for a smooth and organized shoot that all reagents are accounted for, in advance.   

Any overnight or long incubation steps should be recognized and specimens/samples be prepared in advance so that prior steps can be recorded and shooting can continue with pre-prepared specimens/samples.  

All tubes/flasks should be pre-labeled neatly before we arrive.  

Ex. Luciferase assay done in 96 well plates should be labeled with negative/positive control wells and experimental samples are labeled accordingly.

You will receive more detailed preparation instructions are included in the email accompanying the finalized script.
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